Overview of SPSS

There are several excellent texts that give introductions to the general environment within SPSS operates. The best ones include Kinnear and Gray (1997) and Foster (1998). These texts are well worth reading if you are unfamiliar with Windows and SPSS generally because I am assuming at least some knowledge of the system. However I appreciate the limited funds of most students and so to make this text usable for those inexperienced with SPSS I will provide a brief guide to the SPSS environment-but for a more detailed account see the previously cited texts and the SPSS manuals. This book is based primarily on version 10.0 of SPSS (at least in terms of the diagrams); however, it also caters for versions 7.0 and 8.0(there are few differences between versions 7.0, 8.0 and 9.0 and any obvious differences are highlighted where relevant).

Once SPSS has been activated, the program will automatically load two windows: the data editor (this is where you input your data and carry results of any analysis will appear). There are a number of additional windows that can be activated. In versions of SPSS earlier than version 7.0, graphs appear in a separate window known as the chart caroused; however, veroins7.0 and after include graphs in the output window, which is called the output navigator (version 7.0) and the output viewer (version 8.0 and after). Another window that is useful is the syntax window, which allows you to enter SPSS commands manually (rather than using the window-based menus). At most levels of expertise, the syntax window is redundant because you can carry out most analyses by clicking merrily with your mouse. However, there are various additional functions that can be accessed using syntax and sick individuals who enjoy statistics can find numerous uses for it! I will pretty much ignore syntax windows because those of you who want to know about them will learn by playing around and the rest of you will be put off by their inclusion (interested reader should refer to Foster, 1998, Chapter 8).

The Data Editor

The main SPSS window includes a data editor for entering data. This window is where most of the action happens. At the top of this screen is a menu bar similar to the ones you might have seen in other programs (such as Microsoft Word). Figure 1.6 shows this menu bar and the data editor. There are several menus at the top of the screen (e.g. File, Edit etc) that can be activated by using the computer mouse to move the onscreen arrow onto the desired menu and then pressing the left mouse button once (pressing this button is usually known as clicking). When you have clicked on a menu, a menu box will appear that displays a list of options that can be activated by moving the on-screen arrow so that it is pointing at the desired option and then clicking with the mouse. Often, selecting an option from a menu makes a window appear; these windows are referred to as dialog boxes. When referring to selection options in a menu I will notate the action using bold type with arrows indication the path of the mouse (so, each arrow represents placing the on-screen arrow over a word and clicking the mouse’s left button). So, for example, if I were to say that you should select the Save As… option in the File menu, I would write this as select File=>Save As….
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Figure 1.6: The SPSS data editor

Within these menus you will notice that some letters are underlined: these underlined letters represent the keyboard shortcut for accessing that function. It is possible to select many functions without using the mouse, and the experienced keyboard user may find these shortcuts faster than manoeuvring the mouse arrow to the appropriate place on the screen. The letters underlined in the menus indicate that the option can be obtained by simultaneously pressing ALT on the keyboard and the underlined letter. So, to access the Save As … option, using only the keyboard, you should press ALT and F on the keyboard simultaneously (which activates the File menu) then, keeping your finger on the ALT key, press A (which is the underlined letter).

Below is a brief reference guide to each of the menus and some of the options that they contain. This is merely a summary and we will discover the wonders of each menu as we progress through the book.

File: This menu allows you to do general things such as saving data, graphs or output. Likewise, you can open previously saved files and print graphs, data or output. In essence, it contains all of the options that are customarily found in File menus.

Edit: This menu contains edit functions for the data editor. In SPSS for window it is possible to cut and paste blocks of numbers from one part of the data editor to another (which can be very handy when you realize that you’ve entered lots of numbers in the wrong place). You can also use the Options to select various preferences such as the font that is used for the output. The default preferences are fine for most purposed, the only thing you might want to change (form the sake of the environment) is to set the text output page size length of the viewer to infinite
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(this saves hundreds of trees when you come to print things).

Data: This menu allows you make changes to the data editor. The important features are insert variable, which is used to insert a new variable into the data editor (i.e. add a column); insert case, which is used to add a new row of data between two existing rows of data;  split file,  which is used to split the file by a grouping variable(see section 2.4.1); and select cases,  which is used to run analyses on only a selected sample of cases.

Transform: You should use this menu if you want to manipulate one of your variables in some way. For example, you can use recode to change the values of certain variables (e.g. if you wanted to adopt a slightly different coding scheme for some reason). The compute function is also useful for transforming data (e.g. you can create a new variable that is the average of two existing variables). This function allows you to carry out any number of calculations on your variables (see section 6.2.2.1).

Analyze:  This menu is called Statistics in version 8.0 and earlier. The fun begins here, because the statistical procedures lurk in this menu. Below is a brief guide to the options in the statistics menu that will be used during the course of this book(this is only a small portion of what is available):

(a) Descriptive Statistics: This menu is called Summarize  in version 8.0 and earlier. This menu is for conducting descriptive statistics(mean, mode, median etc.), frequencies and general data exploration. There is also a command called  crosstabs that is useful for exploring frequency data and performing tests such as chi-square, Fisher’s exact test and Cohen’s kappa.

(b) Compare Means:  This is where you can find t-tests and one-way independent ANOVA.

(c) General Linear Model: This is called ANOVA Models   in version 6 of SPSS. This menu is for complex ANOVA such as two-way(unrelated, related or mixed),one-way ANOVA with repeated measures and multivariate analysis if variance(MANOVA).

(d) Correlate: It doesn’t take a genius to work out that this is where the correlation techniques are kept! You can do bivariate correlations such as Pearson’s R, Spearman’s rho(() and Kendall’s tau(() as well as partial correlations.

(e) Regression: There are a variety of regression techniques available in SPSS. You can do simple linear regression, multiple linear regression and more advanced techniques such as logistic regression.

(f) Data Reduction: You find factor analysis here.

(g) Nonparametric: There are variety of non-parametric statistics available such the chi-square goodness-of-fit statistic, the binomial test, the Mann-Whitney test, the Kruskal_Wallis test, Wilcoxon’s test and Friedman’s ANOVA.

Graphs: SPSS comes with its own, fairly versatile, graphing package. The types of graphs you can do include: bar charts, histograms, scatterplots, box-whisker plots, pie charts and error bar graphs to name but a few. There is also the facility to edit any graphs to make them look snazzy –which is pretty smart if you ask me.

Views: This menu deals with system specifications such as whether you have grid lines on the data editor, or whether you display value labels(exactly what value labels are will become clear later).

Window: This allows you to switch from window to window. So, if you’re looking at the output and you wish to switch back to your data sheet, you can do so using this menu. There are icons to shortcut most of the options in this menu so isn’t particularly useful.

Help: This is an invaluable menu because it offers you on-line help on both the system itself and the statistical tests. Although the statistics helps files are fairly useless at times(after all, the program is not supposed to teach you statistics) and certainly no substitute for acquiring a good knowledge of your own, they can sometimes get you out of a sticky situation. 


As well a the menus there are also a set of icons at the top of the data editor window(see Figure 1.6) that are shortcuts to specific, frequently used, facilities.  All of these facilities can be accessed via the menu system but using the icons will save you time. Below is a brief list of these icons and their function:
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This icon gives you the option to open a previously saved file(if you are n the data editor SPSS assumes you want to open a data field, if you are in the output viewer, it will offer to open a viewer file).
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This icon allows you to save files. It will save the file you are currently working on(be it data or output). If e file hasn’t already been saved it will produce the  save data as dialog box.
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This icon activates a dialog box for printing whatever you are currently working on(either the data editor or the output). The exact print option will depend on the printer you use. One useful tip when printing from the output window is to highlight the text that you want to print (by holding the mouse button down and dragging the arrow over the text of interest). In version 7.0 onwards, you can also select parts of the output by clicking on branches in the viewer window(see section 1.2.4) when the print dialog box appears remember to click on the option to print only the selected text. Selecting parts of the output will save a lot of trees because by default SPSS will print everything in the output window.
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Clicking this icon will activate a list of the last 12 dialog boxes that were used. From this list you can select any box from the list and it will appear on the screen. This icon makes it easy for you to repeat parts of an analysis.
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This icon allows you to go directly to a case(i.e. a subject). This is useful if you are working on large data files. For example, if you were analyzing a survey with 3000 respondents it would get pretty tedious scrolling down the data sheet to find a particular subject’s responses. This icon can be used to skip directly to a case(e.g. case 2407).Clicking on this icon activates a dialog box that requires you to type in the case number required.
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Clicking on this icon will give you information about a specified variable in the data editor( a dialog box allows you to choose which variable you want summary information about).
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This icon allows you to search for words or numbers in your data file and output window.
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Clicking on this icon inserts a new case in the data editor(so, it creates a blank row at the point that is currently highlighted in the data editor). This function is very useful if you need to add new data or if you forget to put a particular subject’s data in the data editor.
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Clicking this icon creates a new variable to the left of the variable that is currently active (to activate a variable simply click once on the name at the top of the column).
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Clicking on this icon is a shortcut to the Data=>Split File… function (see section 2.401). social scientists often conduct experiments on different groups of people. In SPSS we differentiate groups o people by using a coding variable (see section 1.2.3.1), and this function lets us divide our output by such a variable. For example, we might test males and females on their statistical ability of each gender we simply ask the computer to split the file by the variable gender.  Any subsequent analyses will be performed on the men and women separately.
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This icon shortcut to the Data=>Weight Cases… function. This function is necessary when we come we come to input frequency data and is useful for some advanced issues in survey sampling.
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This icon is a shortcut to the Data=>Select Cases… function. If you want to analyze only a portion of your data, this is the option for you! This function allows you to specify what cases you want to include in the analysis.
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Clicking this icon will either display, or hide, the value labels of any coding variables. We often group people together and use a coding variable to let the computer know that a certain subject belongs to a certain group. For example, if we coded gender as 1=female, 0=male then the computer knows that every time it comes across the value 1 in the gender column, that subject is a female. If you press this icon, the coding will appear on the data editor rather than the numerical values; so, rather than a series of numbers. 

Inputting Data

When you first load SPSS it will provide a blank data editor with the title New Data. When inputting a new set of data, you must input your data in a logical way. The SPSS data editor is arranged such that each row represents data from one subject while each column represents a variable. There is no discrimination between  independent and dependent variables: both types should be placed in a separate column. The key point is that each row represents one participant’s data. Therefore, any information about that case should be entered across the data editor. For example, imagine you were interested in sex differences in perceptions of pain created by hot and cold stimuli. You could place some people’s hands in a bucket of very cold water for a minute and ask them to rate how painful they thought the experience was on a scale of 1 to 10. you could then ask them to hold a hot potato and again measure their perception of pain. Imagine I was a subject. You would have a single row representing my data, so there would be a different column for my name, my age, my gender, my pain perception for cold water, and my pain perception for a hot potato: Andy, 25, male,7,10. the column with the information about my gender is a grouping variable: I can belong to either the group of males or the group of females, but not both. As such, this variable is a between-group variable (different people belong to different groups). Therefore, between-group variables are represented by a single column in which the group to which the person belonged is defined using a number. Variables that specify to which of several groups a person belongs can be used to split up data files (so, in the pain example you could run an analysis on the male and female subjects separately). The two measures of pain are a repeated measure (all subjects were subjected to hot and cold stimuli). Therefore, levels of this variable can be entered in separate columns (one for pain to a hot stimulus and one for pain to a cold stimulus).

In summary, any variable measured with the same subjects( a repeated measure) should be represented by several columns (each column representing one level of the repeated measures variable). However, when a between-group design was used(e.g. different subjects were assigned to each level of the independent variable) the data will be represented by two columns: one that has the values of the dependent variable and one that is a coding variable indicating to which group the subject belonged. 

Creating a Variable

In version 10 of SPSS, when the define variable dial box is selected, then the following screen appears:
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This screen contains fields: Name, Type, Width, Decimals, Label, Values, Missing Values, Columns, Align and measure.

Creating Coding Variables

A coding variable (also know as a grouping variable) is a variable consisting of a series of numbers that represent levels of a treatment variable. In experiments, coding variables are used to represent independent variables that have been measured between groups. So, if you were to run an experiment with one group of subjects in a control group, you might assign the experimental group a code of 1, and the control group a code of 0. when you come to put the data into the data editor, then you would create a variable (which you might call  group) and type in the value 1 for any subjects in the experimental group, and 0 for any subject in the control group. These codes tell the computer that all of the cases that have been assigned the value 1 should be treated as belonging to the same group, and likewise fro the subjects assigned the valued 0.

There is a simple rule for how variables should be placed in the SPSS data editor: levels of the between-group variables go down the data editor whereas levels of within-subject(repeated measures) variables go across the data editor.

To create a coding variable we create a variable in the usual way, but we have to tell the computer which numeric codes we are assigning to which groups. This can be done by using the [image: image16.png]Labels



  button in the define variable  dialog box to open the define labels  dialog box. In the define labels dialog box there is room to give your variable a more descriptive title. For the purposes of the data editor itself. However, for the purpose of the output , it is possible to give our variable a more meaningful title. If you want to give a variable a more descriptive title then simply click with the mouse in the white space next to where it says Variable Label in the dialog box. This will place the cursor in that space, and you can type a title: in 1.8 you can see Experimental Condition. The more important use of this dialog box is to specify group coding. This can be done in three easy steps. First, click with the mouse in the white space next to where it  says Value(or press ALT and  U at the same time) and type in a code. These codes are completely arbitrary: form the sake of convention people usually use 1,2 and 3 etc, but in practice you could have a code of 495 if you were feeling particularly arbitrary. The second step is to click the  mouse in the white space below, next to where it says Value Label(or press ALT and E at the same time) and type in an appropriate label for that group. The third step is to add this coding to the list by clicking on[image: image17.png]Add,



. When you have defined all of your coding values simply click on[image: image18.png]ok



; if you click on [image: image19.png]ok



 and have forgotten to add your final coding to the list, SPSS will display a message warning you that any pending changes will be lost. In plain English this simply tells you to go back and  click on [image: image20.png]Add,



.
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Fig 1.8: Defining coding values in SPSS

Having defined your coding, you can then go to the data editor and type these numerical values into the appropriate column. What is rally groovy is that you can get the computer to display the coding themselves, of the values labels that you gave them by clicking on [image: image22.png]


. Fig 1.9 shows how the data should be arranged for a coding variable. Now remember that each row of the data editor represents one subject’s data and so in this example it is clear that the first five subjects were in the experimental condition whereas subjects 6-10 were in the control group. This example also demonstrates why grouping variables are used for variables that have been measured between subjects: because by using a coding variable it is impossible for a subject to belong to more than one group. This situation should occur in a between-group design(i.e. a subject should not be tested in both the experimental and the control group). However, in repeated measures designs (within subjects) each subject is tested in every condition and so we would not use this sort of coding variable (because each subject does take part in every experimental condition).
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Fig 1.9 Coding values in the data editor with the value labels switched off and on.

Types of Variables

There are different types of variables that can be used in SPSS. In the majority of cases you will find yourself using numeric variables. These variables are ones that contain numbers and include the type of coding variables that have just been described. However, one of the other options when you create a variable is to specify the type of variable and this is done by clicking on [image: image25.png]Types.



 in the define variable dialog box. Clicking this button will activate the dialog box in figure 1.10, which shows the default setting. By default, a variable is set up to store  8 digits, but you can change this value by typing a new number in the space labeled Width in the dialog box. Under normal circumstances you wouldn’t require SPSS to retain any more than 8 characters unless you were doing calculations that need to be particularly precise. Another default setting is to have 2 decimal places displayed . It is easy enough to change the number of decimal places for a given variable by simply replacing the 2 with a new value depending on the level of precision you require.

The  define variable type dialog box also allows you to specify a different type of variable. For the most part you will use numeric values. However, the other variable type of use is a string variable. A string variable is simply a line of text and could represent comments about a certain subject, of other information that you don’t wish to analyze as a grouping variable (such as the subject’s name). If you select the string variable option, SPSS lets you specify the width of the string variable (which by default I s8 characters) so that you can insert longer strings of text if necessary.
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Fig 1.10: Defining the type of variable being used

Missing Values

Although as researchers will e strives to collect complete sets of data, it is often the case that we have missing data. Missing data can occur for a variety of reasons: in long questionnaires participants accidentally miss out questions; in experimental procedures mechanical faults can lead to a datum not being recorded; and in research on delicate topics (e.g. sexual behaviour)subjects may exert their right not to answer a question. However, just because we have missed out some data for a subject doesn’t mean that we have to ignore the data we do have. However, we do need to tell the computer that a value is missing for a particular subject. The principle behind missing values is quite similar to that of coding variables in that we choose a numeric value to represent the missing data point. This value simply tells the computer that there is no recorded value for a participant for a certain variable. The computer  then ignores that cell of the data  editor. You need to be careful that the chosen code doesn’t correspond with any naturally occurring data value. For example, if ewe tell the computer to regard the value 9 as a missing value and several subjects genuinely scored 9, then the computer will treat their data as missing when, in reality, it is not.
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Fig 1.11: Defining missing values

To specify missing values you simply click on [image: image28.png]Missingvalues,



 in the define variable dialog box to activate the  define missing values dialog box. By default SPSS assumes that no missing values exist but if you do have data with missing values you can choose to define them in one of three ways. The first is to select  discrete values(by clicking on the circle next to where it says Discrete missing value), which are single, values that represent missing data. SPSS allows you to specify up to three discrete values to represent missing data. The reason why you might choose to have several numbers to represent messing values is that you can assign a different meaning to each discrete value. For example, you could have the number 8 representing a response of ‘not applicable’, a code of 9 representing a ‘don’t know ‘ response, and a code of 99  meaning that the subject failed to give any response. As far as the computer is concerned it will ignore any data cell containing these values; however, using different codes may be a useful way to remind you of why a particular score is missing. Usually, one discrete value is enough and in an experiment in which attitudes are measured on a 100 point scale(so score vary from 1 to 100) you might choose 999 to represent missing values because this value cannot occur in the data that have been collected. The second option is to select a range of values to represent missing data and this is useful in situations in which it is necessary to exclude data falling between two points. So, we could exclude all scores between 5 and 10. The final option is to have a range of values and one discrete value.

The Output Viewer

Alongside the main SPSS window, there is a second window known as the output viewer(or output navigator in version 7.0 and 7.5). In earlier versions of SPSS this is simply called the output window and its function is, in essence, the same. However, whereas the output windows of old displayed only statistical results, the new , improved and generally amazing output viewer will happily display graphs, tables and statistical results and all in a much nicer font. Rumour has it that future versions of SPSS will even include a tea-making facility in the output viewer. On the right-hand side there is a large space in which the output is displayed . SPSS displays both graphs and the results of statistical analyses in this part of the viewer. It is also possible to edit graphs and to do this you simply double-click on the graph you wish to edit. On the left-hand side of the output viewer there is a tree diagram illustrating the structure of the output. This tree diagram is useful when you have conducted several analyses because it provides an easy way of accessing specific parts of the output. The tree structure is fairly self-explanatory in that every time you conduct a procedure(such as drawing a graph or running a statistical procedure), SPSS lists this procedure as a main heading.
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Fig: 1.13 The output viewer

In figure 1.13 , it shows a graphing procedure and then a univariate analysis of variance(ANOVA) and so these names appear as main headings. For each procedure there are a series of sub-procedures, and these are listed as branches under the main headings. For example, in the ANOVA procedure there are a number of sections to the output such as a Levene’s test (which tests the assumption of homogeneity of variance) and the between-group effects(i.e. the F-test of whether the means are significantly different). You can skip to any one of these sub-components of the ANOVA output by clicking on the appropriate branch of the tree diagram. So, if you wanted to skip straight to the between-group effects you should move the on-screen arrow to the left-hand portion of the window and click where it says  Tests of Between Subjects Effects. This action will highlight this part of the output in the main part of the viewer. You can also use this tree diagram to select parts of the output. For example, if you decided that you wanted to print out a graph but you didn’t want to print the whole output, you can click on the word Graph in the tree structure and that graph will become highlighted in the output. It is then possible through the print menu to select to print only the selected part of the output. In this context it is worth noting that if you click on a main heading(such as Univariate Analysis of Variance) then SPSS will highlight not only that main heading but all of the sub-components as well. This is extremely useful when you want to print the results of a single statistical procedure.

There are a number of icons in the output viewer window that help you to do things quickly without using the drop-down menus. Some of these icons are the same as those described for the data editor window so I will concentrate mainly on the icons that are unique to the viewer window .
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As with the data editor window, this icon activates the print menu. However, when this icon is pressed in the viewer window it activates a menu for printing the output. When the print menu is activated you are given the default option of printing the whole output, or you can choose to select an option for printing the output currently visible on the screen, or most useful is an option to print a selection of the output. To choose this last option you must have already selected part of the output.
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This icon returns you to the data editor in a flash!
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This icon takes  you to the last output in the viewer(so, it returns you to the last procedure you conducted).
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This icon promotes the currently active part of the tree structure to a higher branch of the tree. For example, in fig 1.13 the Test of Between-Subjects Effects are a sub-component under the heading of Univariate Analysis of Variance. If we wanted to promote this part of the output to a higher level then this is done using this icon.
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This icon is the opposite of the above in that it demotes parts of the tree structure. For example, in fig 1.13, if we didn’t want the Univariate Analysis of Variance to be a unique section we could select this heading and demote it so that it becomes part of the previous heading (the Graph heading. This button is useful for combining parts of the output relating to a specific research question.
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This icon collapses parts of the tree structure, which simply means that it hides the sub-components under a particular heading. For example, in fig 1.13 if we selected the heading Univariate Analysis of Variance and pressed this icon, all of the sub-headings would disappear. The sections that disappear from the tree structure don’t disappear from the output itself; the tree structure is merely condensed. This can be useful when you have been conducting lots of analyses and the tree diagram is becoming very complex.
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This icon expands any collapsed sections. By default all of the main headings are displayed in the tree diagram in their expanded form. If you have opted to collapse part of the tree diagram then you can use this icon to undo your dirty work.
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This icon and the following one allow you to show and hide parts of the output itself. So, you can select part of the output in the tree diagram and click on this icon and that part of the output will disappear. It isn’t erased, but it is hidden from view. So, this icon is similar to the collapse icon, except that  it affects the output rather than the tree structure. This is useful for hiding less relevant parts of the output.
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This icon undoes the previous one, so if you have hidden a selected part of the output from view and you click on this icon, that part of the output will reappear. By default, all parts of the output are shown and so this icon is not active: it will become active only once you have hidden part of the output.
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Although this icon looks rather like a paint roller, it unfortunately does not paint the house for you. What it does do is to insert a new heading into the tree diagram. For example , if you had several statistical tests that related t one of many research questions you could insert a main heading and then demote the headings of the relevant analyses so that they all fall under this new heading.
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Assuming you had done the above, you can use this icon to provide your new heading with a title. The title you type in will actually appear in your output. So, you might have a heading like ‘Research Question number 1’ which tells you that the analyses under this heading relate to your first research question.
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This final icon is used to place a text box in the output window. You can type anything into this box. In the context of the previous two icons, you might use a text box t explain what your first research question is.

Saving Files

Although most of you should be familiar with how to save files in windows it is a vital thing to know and so I will briefly describe what to do. To save files simply use the [image: image42.png]


 icon(or use the menus: File=>Save or File=>SaveAs…). If the file is a new file, then clicking this icon will activate the SaveAs… dialog box (see fig 1.14). if you are in the date editor when you select SaveAs… then SPSS will save the data file you are currently working on, but if you are in the viewer window then it will save the current output.

There are a number of features of the dialog box in fig 1.14. First, you need to select a location where you can save data: the hard drive(or drives) and the floppy drive(and with the advent of rewritable CD-ROM drives, zip drives, jaz drives and the like you may have many other choices of location on your particular computer) the first thing to is select  either the floppy drive, by double clicking on[image: image43.png]


,or the hard drive, by double clicking on[image: image44.png]


 . Once you have chosen a main location the dialog box will display all of the available folders on that particular device(you may not have any folders on your floppy disk in which case you can create a folder by clicking on[image: image45.png]


 ). Once you have selected a folder in which to save your file, you need to give your file a name. If you click in the space next to where it says File name, a cursor will appear and you can type a name of up to ten letters. By default, the file will be saved in as SPSS format, so if it is a data file it will have the file extension .sav,  and if it is a viewer document it will have the file extension .spo. However, you  can save data in different formats such as Microsoft Excel files and tab-delimited text. To do this just click on [image: image46.png]


 where it says. Save as type and a list of possible file formats will be displayed . click on the file type you require. Once a file has previously been saved, it can be saved again(updated)by clicking [image: image47.png]


. This icon appears in both the data editor and the viewer, and the file saved depends on the window that is currently active. The file will be saved in the location at which it is currently stored.
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Fig: 1.14: The save data as dialog box

Retrieving a File

Throughout this book you will work with data files that have been provided on a floppy disk. It is, therefore, important that you know  how to load these data files into SPSS. The procedure is very simple. To open a file,  simply use the[image: image49.png]¥



 icon(or use the menus: File=>Open) to activate  the dialog box in fig 1.15. First you need to find the location at which the file is stored. If you are loading a file from the floppy disk then access the floppy drive by clicking on [image: image50.png]


  where it says Look in  and a list of possible location drives will be displayed. Once the floppy drive has been accessed you should see a list of files and folders that can be opened. As with saving a file, if you are currently in the data editor then SPSS will display only SPSS data files to be opened (if you are in the viewer window then only output files will be displayed). You can open a folder by double-clicking on the folder icon. Once you have tracked down the required file you can open it either by selecting it with the mouse and then clicking on [image: image51.png]


, or by double-clicking on the icon next to the file you want (e.g. double-clicking on[image: image52.png]


). The data/output will then appear in the appropriate window. If you are in the data editor and you want to open a viewer file , then click on [image: image53.png]


  where it says Files of type and a list of alternative file formats will be displayed. Click on the appropriate file type(viewer document(*.spo). Excel file(*.xls), text file(*.dat, *.txt)) and any files of that type will be displayed for you to open.
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Fig 1.15:Dialog box to open a file
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